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Spotfire Enterprise Runtime for R Release Notes

The Release Notes for this product version are provided to inform you of new features, known issues,
and issues from previous releases that have been closed.

These release notes are for Spotfire® Enterprise Runtime for R ( a/k/a TERR™)  version 6.1 (LTS). They
cover Linux® and Microsoft Windows® installations.

As of version 6.0.3, support for using TERR on macOS is removed.

TERR™ is a high-performance statistical engine, which is compatible with open-source R. It can be
embedded into a wide range of applications as an enterprise-grade alternative to open-source R, and
can run a wide array of packages from CRAN.

Open-source R is available under separate open source software license terms and is not part
of TERR. As such, open-source R is not within the scope of your license for TERR. Open-
source R is not supported, maintained, or warranted in any way by Cloud Software Group, Inc.
Download and use of open-source R is solely at your own discretion and subject to the free open
source license terms applicable to open-source R.

New Features

Version 6.1 of Spotfire® Enterprise Runtime for R ( a/k/a TERR™)  contains the following new features.

Version 6.1.4

Version 6.1.4 of TERR™ has no new features.

Version 6.1.3

Version 6.1.3 of TERR™ has no new features.

Version 6.1.2

Version 6.1.2 of TERR™ has no new features.

Version 6.1.1

KEY Description

TERR-7987 TERR is supported to run on Ubuntu 22.04. See the System Requirements for more information.

TERR-7992 TERR is supported to run on Red Hat Enterprise Linux (RHEL) 9. See the System Requirements for
more information.

Version 6.1.0

In version 6.1.0, the product is renamed from TIBCO® Enterprise Runtime for R to Spotfire® Enterprise
Runtime for R (a/k/a TERR).

● Documentation, file paths, and product information reflect the new name.

● Programming and internal elements, such as library names, extension function names, and function
names, retain the old names for backward compatibility.

Spotfire® Enterprise Runtime for R Release Notes
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Changes in Functionality, Features, and Compatibility

Version 6.1 of TERR contains no changes in functionality.

Deprecated and Removed Features

Version 6.1 of TERR has deprecated or removed the following features.

TERR 6.1.4

Deprecated
Version 6.1.4 of TERR has no deprecated features.

Removed
Version 6.1.4 of TERR has no removed features.

TERR 6.1.3

Deprecated
Version 6.1.3 of TERR has no deprecated features.

Removed
Version 6.1.3 of TERR has no removed features.

TERR 6.1.2

Deprecated
Version 6.1.2 of TERR has no deprecated features.

Removed
Version 6.1.2 of TERR has no removed features.

TERR 6.1.1

Deprecated
Version 6.1.1 of TERR has no deprecated features.

Removed
Version 6.1.1 of TERR has no removed features.

TERR 6.1.0

Deprecated
Version 6.1.0 of TERR has no deprecated features.

Removed

● RHEL 7 is no longer a supported operating system for TERR.
● Debian 10 is no longer a supported operating system for TERR.

Spotfire® Enterprise Runtime for R Release Notes



5

Third Party Software Updates

Version 6.1 of TERR contains the following third-party software updates.

Key Version Summary

TERR-8084 6.1.4
● libarchive updated to 3.7.4

● cURL updated to 8.9.1

● OpenSSL updated to 3.0.14

TERR-8062 6.1.3
● cURL updated to 8.7.1

● libxml2 updated to 2.12.6

● Olson timezone database updated to 2024a

● Applied mitigations to unzip for CVE-2015-7696, CVE-2015-7697, CVE-2016-9844, and
CVE-2018-18384

TERR-8058 6.1.2
● cURL updated to 8.5.0

TERR-8052 6.1.1
● cURL updated to 8.4.0

● libarchive (bsdtar) updated to 3.7.2

● libxml2 updated to 2.11.6

● OpenSSL updated to 3.0.12

TERR-8013 6.1.0
● cURL updated to 8.2.1

● OpenSSL updated to 3.0.10

Package Compatibility

We have reported the results of tests of CRAN packages using TERR in visualizations that are available
on TIBCO™ Cloud® Spotfire at the following links. You can browse and review the results for the
packages you want to use and their Task Views. You can review the results run for every expression in
every help file for every CRAN package or BioConductor package for the following platforms.

Beginning with release 5.1, we also run all help examples provided in packages in the Bioconductor
(BIOC) list.

To see a complete listing of the Rapi C API functions implemented in TERR, run the following
code.

library(terrUtils)
implementedRapiEntries()

Package compatibility analysis in Spotfire

We reported the results of tests of CRAN packages using TERR 6.0 in visualizations that are available
on TIBCO™ Cloud® Spotfire at the following links. You can browse and review the results for the
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packages you want to use and their Task Views. You can review the results run for every expression in
every help file for every CRAN package or BioConductor package for the following platforms.

CRAN packages BioConductor packages

Windows Windows

Linux Linux

The tests run against code examples in the help provide some guidance for determining rates of
success. The accuracy of information collected depends on the number and quality of examples in
the package reference topics. These analyses are not meant to be the definitive determination of exact
compatibility.

For more information about CRAN packages, see https://cran.r-project.org/web/packages/

● For more information about BioConductor packages, see https://www.bioconductor.org/packages/
release/bioc/

Spotfire does not warrant, deliver, or support code or other material provided by the R Project
for Statistical Computing, including but not limited to development tools and packages, and
such code and other material does not constitute a part of TERR. Such material therefore is not
within the scope of your license for TERR. Download and use of such material is solely at your
own discretion and subject to the free open source license terms applicable to such material.
Consult a legal professional concerning compliance with any free open source license terms
applicable to such material, particularly if you plan to engage in redistribution of TERR and/
or such material. (Please note that TERR may be redistributed solely pursuant to a license that
expressly grants such redistribution rights.)

Package compatibility summary in TERR

Alternatively, we provide a summary of our testing results on the documentation site in the following
CSV-formatted files.

● CRANonTERR-Linux.csv

● CRANonTERR-Win.csv

● BIOConTERR-Linux.csv

● BIOConTERR-Win.csv

TERR console code example for CRAN
You can use the TERR console to quickly access a summary of the information. The following example
returns the results for testing the help files for the CRAN package caret. You can change the example
to match the platform and package of your choice.

1. Change the CSV file name to match the platform (Linux or Windows).
2. Remove the comment markers for the CSV file name.
3. Provide the name of the package you want to query.

# Example:  CRAN tests compatibility with this version of TERR
#
#packageCompat <- read.csv("https://docs.tibco.com/pub/enterprise-runtime-for-R/6.1.3/doc/
csv/CRANonTERR-Linux.csv", 
#   stringsAsFactors=FALSE)
#
#packageCompat <- read.csv("https://docs.tibco.com/pub/enterprise-runtime-for-R/6.1.3/doc/
csv/CRANonTERR-Win.csv", 
#   stringsAsFactors=FALSE)
#
subset(packageCompat, Package.Name=="caret")

Spotfire® Enterprise Runtime for R Release Notes
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## (update)

The returned results resemble the following for the above example.

    Package.Name Version            Status Percent.Successful Total.Executed
1608        caret  6.0-86 Mostly successful                98.5%            205
    Passed Failed Graphics Random.Numbers
1608    202      3       17             100

This table shows how to read the results for this example. (Shows sample results for running the
example on Linux. Results for Windows can vary slightly.)

Column name Result

Package.Name caret

Version 6.0-86

Status Mostly successful

Percent.Successful 98.5%

Total.Executed 205

Passed 202

Failed 3

Graphics 17

Random.Numbers 100

TERR console code example for BioConductor
You can use the TERR console to quickly access a summary of the information. The following example
returns the results for testing the help files for the BioConductor package limma. You can change the
example to match the platform and package of your choice.

1. Change the CSV file name to match the platform (Linux or Windows).
2. Remove the comment markers for the CSV file name.
3. Provide the name of the package you want to query.

# Example:  BioConductor tests compatibility with this version of TERR
#
#packageCompat <- read.csv("https://docs.tibco.com/pub/enterprise-runtime-for-R/6.1.3/doc/
csv/BioConTERR-Linux.csv", 
#   stringsAsFactors=FALSE)
#
#packageCompat <- read.csv("https://docs.tibco.com/pub/enterprise-runtime-for-R/6.1.3/doc/
csv/BioConTERR-Win.csv", 
#   stringsAsFactors=FALSE)
#
subset(packageCompat, Package.Name=="limma")
## (update)

The returned results resemble the following for the above example.

Package.Name Version            Status Percent.Successful Total.Executed
901        limma  3.44.3 Mostly successful               96.9            391
    Passed Failed Graphics Random.Numbers

Spotfire® Enterprise Runtime for R Release Notes
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901    379     12       49             75

This table shows how to read the results for this example. (Shows sample results for running the
example on Linux. Results for Windows can vary slightly.)

Column name Result

Package.Name limma

Version 3.44.3

Status Mostly successful

Percent.Successful 96.9%

Total.Executed 391

Passed 379

Failed 12

Graphics 49

Random.Numbers 75

Update or Reinstall a Version of TERR

When you update to a more recent version of TERR, remove the previous version, and follow the
guidelines to protect your installed packages.

Installing TERR over a previous TERR installation without removing it can cause unexpected
failures. To remove TERR, follow the instructions for your operating system.

For a list of operating systems that TERR is supported on, see the Spotfire Enterprise Runtime
for R system requirements.

When you update to a new version of TERR, follow the guidance in "Package installation locations and
recommendations for updating" in the Package Management section of the Spotfire® Enterprise Runtime
for R Technical Documentation.

On Linux

● From the command line, run the command rm -rf TERR_HOME, where TERR_HOME is the installation
directory.

On Windows

● From the Settings app, click Apps, and then from the Apps & features list, double-click run the
listing Spotfire Enterprise Runtime for R <version#>.

After uninstalling TERR, run the installer for the version of TERR you want to install.

Closed Issues

Version 6.1 of TERR contains the following closed issues.

Spotfire® Enterprise Runtime for R Release Notes
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TERR 6.1.4

Key Description

TERR-8039 Current versions of RStudio Desktop do not start up when configured with Spotfire Enterprise Runtime
for R.

TERR-8073 Certain CRAN packages, such as dplyr, cannot be loaded into TERR using a library(dplyr) call due to
embedded promises in the package lazy load databases.

TERR-8091 formatC returns bad values when you format strings that contain values not representable as an integer (
that is, values above approximately 2.1 billion or below approximately -2.1 billion) using format='d'.

TERR 6.1.3

Key Description

TERR-8060 The function rbinom() can generate unexpected erroneous results in some cases.

TERR-8039 Current versions of RStudio Desktop do not start up when configured with Spotfire Enterprise Runtime
for R.

TERR 6.1.2

Version 6.1.2 has no closed issues.

TERR 6.1.1

Version 6.1.1 of TERR contains the following closed issues.

Key Description

TERR-8050 The first time you open RStudio from TERR Tools in the Spotfire Analyst, you might see an error saying
that the file Desktop.ini is not found.

TERR 6.1.0

Version 6.1.0 of TERR contains the following closed issues.

Key Description

TERR-8035 The data set for the aggregation example includes column names with a different case than the case used
in the example, causing the function to fail.

TERR-8034 The htmlTable function in the SpotfireUtils package does not properly escape user-provided characters as
HTML entities.

TERR-8033 Trying to create a classification model in Spotfire using a large number of columns results in Spotfire
becoming unresponsive.

Known Issues

Version 6.1 of TERR contains the following known issues.

Spotfire® Enterprise Runtime for R Release Notes
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In this release, some open-source R functionality is not available, including graphics devices, and some
functions from the base and stats packages. Likewise, S4 is not entirely compatible. The following table
lists additional known issues.

Issue Description

TERR-4993 On Linux, you cannot save TERR Command History to a file.

TERR-5488 If you receive the message "SSL certificate problem: unable to get local issuer certificate"
 when accessing SSL protected URLs (for example, https://), make sure that your system has the latest
version of the certificate authority database for your system. On RedHat 5, this should be `yum update
openssl`. On RedHat 6, this should be `yum update ca-certificates`.

TERR-6422 Setting breakpoints in RStudio 0.99.903 with TERR on Windows can cause it to crash. When a script is
sourced, and if it has breakpoints set, RStudio for Windows can crash. This crash does not occur when
breakpoints are set inside a function and the function is called.

TERR-6576 If you try to use an RStudio feature that requires the rmarkdown package or the shiny package, and the
required package is not already installed, then this process currently fails if RStudio is configured with
the TERR engine. To work around this problem, at the command prompt, call install.packages() to
install the rmarkdown and shiny packages.

TERR-6812 Due to changes in open-source R version 3.5 and resulting compatibility changes in TERR 5.0, packages
that are built with a version of TERR prior to 5.0 must be rebuilt.

● To install a binary package from a repository, always call install.packages(pkgname) from TERR.
 The install.packages function finds the correct binary version in the repository for your version
of TERR. Manually downloading the binary package from CRAN can result in errors when you use it
with TERR.

● To install a package from source, try installing it first with TERR (with install.packages in TERR or
with TERR CMD INSTALL from a command line).

● To install a package from source that you cannot build with TERR, install the package with the
version of open-source R tested with TERR.

TERR-7077 Certain packages, such as rJava, cannot be installed with TERR from source under Centos. If you
encounter a package that does not install with TERR from source, then you can build the package using
open-source R, and then install the binary package in TERR.

TERR-7727 When you view help files in Rstudio, some text in the help (for example, the Arguments and the Value
sections) might not be visible if you are using an Rstudio Editor theme with a dark background.

TERR-7728 When you run TERR under Rstudio Server, if you end the session using File > Quit Session, the following
message is displayed: Session Error, The previous R session was abnormally terminated due
to an unexpected crash. This problem can also occur when you open a project using the File > New
Project or File > Open Project menu commands.

Package search order

When you install a package using TERR, by default, TERR first checks for the package on TRAN, and
then checks on Posit. TERR installs the first version it finds. This is different than open-source R, which
installs packages according to the newest version number available on CRAN. This difference is by
design, because occasionally a CRAN package update causes a break with TERR compatibility, so we
make available a tested version of the package on TRAN.

If you need to install one of these packages using open-source R (for example, to get source code on
Linux), you can install the CRAN package, and then set options()$repos to install from only TRAN
before reinstalling the package.

See "Specifying an older package on TRAN" in the Spotfire® Enterprise Runtime for R Technical
Documentation for more information.

Spotfire® Enterprise Runtime for R Release Notes
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When running on RedHat Linux, Spotfire Enterprise Runtime for R processes spawned by the
parallel package may immediately crash

We have seen a problem when running TERR on RedHat Linux with versions of Java earlier than
1.7.0_40. If you call the makeCluster function in the parallel package to spawn new TERR processes,
these processes may immediately crash with a fatal Java error. To test if this problem is occurring, try
the following:

library(parallel)
c1 <- makeCluster(1, outfile="")
# create cluster with one spawned process
# specifying outfile="" to print all output
c1 <- makeCluster(1, outfile="")
clusterEvalQ(c1, 123)

If this problem is occurring, you see an error such as the following:

> library(parallel)
> # create cluster with one spawned process
> # specifying outfile="" to print all output from the process
> c1 <- makeCluster(1, outfile="")
Creating 1 TERR cluster nodes at Tue Nov 21 9:38:25 2023
> clusterEvalQ(c1, 123)
1: #
1: # A fatal error has been detected by the Java Runtime Environment:
1: #
1: # SIGSEGV (0xb) at pc=0x0000003ac2cbbfa5, pid=12649, tid=1075054912
1: #1: # JRE version: 7.0_13-b20
1: # Java VM: Java HotSpot(TM) 64-Bit Server VM (23.7-b01 mixed mode linux-amd64 
compressed oops)
1: # Problematic frame:
1: # C [libstdc++.so.6+0xbbfa5) __cxa_allocate_exception+0x55
1: #
1: # Failed to write core dump. Core dumps have been disabled. To enable core 
dumping, try "ulimit -c unlimited" before starting Java again
1: #
1: # An error report file with more information is saved as:
1: # /a/seafiler01.na.tibco.com/vol/vol2/users/jdoe/hs_err_pid12649.log
1: #
1: # If you would like to submit a bug report, please visit:
1: # http://bugreport.sun.com/bugreport/crash.jsp
1: #
Error in waitForClusterReady(cl) : some cluster nodes have crashed or stopped: all crashed

The workaround for this problem is to set the LD_PRELOAD environment variable to libstdc++.so.6.
This can be done before TERR is started, or within TERR, before the parallel library has been loaded:

> Sys.setenv("LD_PRELOAD"="libstdc++.so.6")
> library(parallel)
> c1 <- makeCluster(1, outfile="")
Creating 1 TERR cluster nodes at Tue Nov 21 10:18:56 2023
> # create cluster with one spawned process
> # specifying outfile="" to print all output
> c1 <- makeCluster(1, outfile="")
Creating 1 TERR cluster nodes at Tue Nov 21 10:19:51 2023
> clusterEvalQ(c1, 123)
1: Cloud Software Group, Inc. Confidential Information
1: Copyright (C) 2011-2023 Cloud Software Group, Inc. ALL RIGHTS RESERVED
1: Spotfire Enterprise Runtime for R version 6.1.1 for Microsoft Windows 64-bit
1:
1: Type 'help()' for help.
1: Type 'q()' to quit.
1: started engine node pid==15788 at Tue Nov 21 10:23:54 2023
[[1]]
[1] 123
>

Spotfire® Enterprise Runtime for R Release Notes
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Spotfire Documentation and Support Services

For information about the Spotfire® products, you can read the documentation, contact Spotfire
Support, and join the Spotfire Community.

How to Access Spotfire Documentation

Documentation for Spotfire and TIBCO products is available on the TIBCO Product Documentation
website, mainly in HTML and PDF formats.

The website is updated frequently and is more current than any other documentation included with the
product.

Spotfire Documentation

The documentation for all Spotfire products is available on the Spotfire Documentation page. This page
takes you directly to the latest version of each document.

To see documents for a specific Spotfire product or version, click the link of the product under 'Other
versions', and on the product page, choose your version from the top right selector.

Release Version Support

Some release versions of Spotfire products are designated as long-term support (LTS) versions. LTS
versions are typically supported for up to 36 months from release. Defect corrections will typically be
delivered in a new release version and as hotfixes or service packs to one or more LTS versions. See also
https://spotfi.re/lts.

How to Contact Support for Spotfire Products

You can contact the Support team in the following ways:

● For accessing the Support Knowledge Base and getting personalized content about products you are
interested in, visit the support portal at https://spotfi.re/support.

● For creating a Support case, you must have a valid maintenance or support contract with Cloud
Software Group, Inc. You also need a user name and password to log in to https://spotfi.re/support.
If you do not have a user name, you can request one by clicking Register on the website.

System Requirements for Spotfire Products

For information about the system requirements for Spotfire products, visit https://spotfi.re/sr.

How to join the Spotfire Community

The Spotfire Community is the official channel for Spotfire customers, partners, and employee
subject matter experts to share and access their collective experience. The Community offers access to
Q&A forums, product wikis, and best practices. It also offers access to extensions, adapters, solution
accelerators, and tools that extend and enable customers to gain full value from Spotfire products.
In addition, users can submit and vote on feature requests from within the Ideas Portal. For a free
registration, go to https://spotfi.re/community.

Spotfire® Enterprise Runtime for R Release Notes
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Legal and Third-Party Notices

SOME CLOUD SOFTWARE GROUP, INC. ("CLOUD SG") SOFTWARE AND CLOUD SERVICES
EMBED, BUNDLE, OR OTHERWISE INCLUDE OTHER SOFTWARE, INCLUDING OTHER
CLOUD SG SOFTWARE (COLLECTIVELY, "INCLUDED SOFTWARE"). USE OF INCLUDED
SOFTWARE IS SOLELY TO ENABLE THE FUNCTIONALITY (OR PROVIDE LIMITED ADD-ON
FUNCTIONALITY) OF THE LICENSED CLOUD SG SOFTWARE AND/OR CLOUD SERVICES. THE
INCLUDED SOFTWARE IS NOT LICENSED TO BE USED OR ACCESSED BY ANY OTHER CLOUD
SG SOFTWARE AND/OR CLOUD SERVICES OR FOR ANY OTHER PURPOSE.

USE OF CLOUD SG SOFTWARE AND CLOUD SERVICES IS SUBJECT TO THE TERMS
AND CONDITIONS OF AN AGREEMENT FOUND IN EITHER A SEPARATELY EXECUTED
AGREEMENT, OR, IF THERE IS NO SUCH SEPARATE AGREEMENT, THE CLICKWRAP END USER
AGREEMENT WHICH IS DISPLAYED WHEN ACCESSING, DOWNLOADING, OR INSTALLING
THE SOFTWARE OR CLOUD SERVICES (AND WHICH IS DUPLICATED IN THE LICENSE FILE) OR
IF THERE IS NO SUCH LICENSE AGREEMENT OR CLICKWRAP END USER AGREEMENT, THE
LICENSE(S) LOCATED IN THE "LICENSE" FILE(S) OF THE SOFTWARE. USE OF THIS DOCUMENT
IS SUBJECT TO THOSE SAME TERMS AND CONDITIONS, AND YOUR USE HEREOF SHALL
CONSTITUTE ACCEPTANCE OF AND AN AGREEMENT TO BE BOUND BY THE SAME.

This document is subject to U.S. and international copyright laws and treaties. No part of this document
may be reproduced in any form without the written authorization of Cloud Software Group, Inc.

Spotfire, the Spotfire logo, TERR, and TIBCO are either registered trademarks or trademarks of Cloud
Software Group, Inc. in the United States and/or other countries. A list of Cloud SG's trademarks and
trademark guidelines is available at https://www.cloud.com/legal.

All other product and company names and marks mentioned in this document are the property of their
respective owners and are mentioned for identification purposes only. You acknowledge that all rights
to these third party marks are the exclusive property of their respective owners. Please refer to Cloud
SG's Third Party Trademark Notices (https://www.cloud.com/legal) for more information.

This document includes fonts that are licensed under the Apache License, Version 2.0, which is
available at https://www.apache.org/licenses/LICENSE-2.0 and reprinted in the Addendum below.

Copyright (c) Christian Robertson / Google, Roboto font.

Cloud SG software may be available on multiple operating systems. However, not all operating system
platforms for a specific software version are released at the same time. See the "readme" file for the
availability of a specific version of Cloud SG software on a specific operating system platform.

THIS DOCUMENT IS PROVIDED "AS IS" WITHOUT WARRANTY OF ANY KIND, EITHER
EXPRESS OR IMPLIED, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF
MERCHANTABILITY, FITNESS FOR A PARTICULAR PURPOSE, OR NON-INFRINGEMENT.

THIS DOCUMENT COULD INCLUDE TECHNICAL INACCURACIES OR TYPOGRAPHICAL
ERRORS. CHANGES ARE PERIODICALLY ADDED TO THE INFORMATION HEREIN; THESE
CHANGES WILL BE INCORPORATED IN NEW EDITIONS OF THIS DOCUMENT. CLOUD SG MAY
MAKE IMPROVEMENTS AND/OR CHANGES IN THE PRODUCT(S), THE PROGRAM(S), AND/OR
THE SERVICES DESCRIBED IN THIS DOCUMENT AT ANY TIME WITHOUT NOTICE.

THE CONTENTS OF THIS DOCUMENT MAY BE MODIFIED AND/OR QUALIFIED, DIRECTLY
OR INDIRECTLY, BY OTHER DOCUMENTATION WHICH ACCOMPANIES THIS SOFTWARE,
INCLUDING BUT NOT LIMITED TO ANY RELEASE NOTES AND "README" FILES.

This and other products of Cloud SG may be covered by registered patents. For details, please refer to
the Virtual Patent Marking document located at https://www.tibco.com/patents.

Copyright © 1988-2024 Cloud Software Group, Inc. All Rights Reserved.
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Addendum to Legal and Third-Party Notices

                                 Apache License
                           Version 2.0, January 2004
                        http://www.apache.org/licenses/

   TERMS AND CONDITIONS FOR USE, REPRODUCTION, AND DISTRIBUTION

   1. Definitions.

      "License" shall mean the terms and conditions for use, reproduction,
      and distribution as defined by Sections 1 through 9 of this document.

      "Licensor" shall mean the copyright owner or entity authorized by
      the copyright owner that is granting the License.

      "Legal Entity" shall mean the union of the acting entity and all
      other entities that control, are controlled by, or are under common
      control with that entity. For the purposes of this definition,
      "control" means (i) the power, direct or indirect, to cause the
      direction or management of such entity, whether by contract or
      otherwise, or (ii) ownership of fifty percent (50%) or more of the
      outstanding shares, or (iii) beneficial ownership of such entity.

      "You" (or "Your") shall mean an individual or Legal Entity
      exercising permissions granted by this License.

      "Source" form shall mean the preferred form for making modifications,
      including but not limited to software source code, documentation
      source, and configuration files.

      "Object" form shall mean any form resulting from mechanical
      transformation or translation of a Source form, including but
      not limited to compiled object code, generated documentation,
      and conversions to other media types.

      "Work" shall mean the work of authorship, whether in Source or
      Object form, made available under the License, as indicated by a
      copyright notice that is included in or attached to the work
      (an example is provided in the Appendix below).

      "Derivative Works" shall mean any work, whether in Source or Object
      form, that is based on (or derived from) the Work and for which the
      editorial revisions, annotations, elaborations, or other modifications
      represent, as a whole, an original work of authorship. For the
 purposes
      of this License, Derivative Works shall not include works that remain
      separable from, or merely link (or bind by name) to the interfaces of,
      the Work and Derivative Works thereof.

      "Contribution" shall mean any work of authorship, including
      the original version of the Work and any modifications or additions
      to that Work or Derivative Works thereof, that is intentionally
      submitted to Licensor for inclusion in the Work by the copyright owner
      or by an individual or Legal Entity authorized to submit on behalf of
      the copyright owner. For the purposes of this definition, "submitted"
      means any form of electronic, verbal, or written communication sent
      to the Licensor or its representatives, including but not limited to
      communication on electronic mailing lists, source code control
 systems,
      and issue tracking systems that are managed by, or on behalf of, the
      Licensor for the purpose of discussing and improving the Work, but
      excluding communication that is conspicuously marked or otherwise
      designated in writing by the copyright owner as "Not a Contribution."
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      "Contributor" shall mean Licensor and any individual or Legal Entity
      on behalf of whom a Contribution has been received by Licensor and
      subsequently incorporated within the Work.

   2. Grant of Copyright License. Subject to the terms and conditions of
      this License, each Contributor hereby grants to You a perpetual,
      worldwide, non-exclusive, no-charge, royalty-free, irrevocable
      copyright license to reproduce, prepare Derivative Works of,
      publicly display, publicly perform, sublicense, and distribute the
      Work and such Derivative Works in Source or Object form.

   3. Grant of Patent License. Subject to the terms and conditions of
      this License, each Contributor hereby grants to You a perpetual,
      worldwide, non-exclusive, no-charge, royalty-free, irrevocable
      (except as stated in this section) patent license to make, have made,
      use, offer to sell, sell, import, and otherwise transfer the Work,
      where such license applies only to those patent claims licensable
      by such Contributor that are necessarily infringed by their
      Contribution(s) alone or by combination of their Contribution(s)
      with the Work to which such Contribution(s) was submitted. If You
      institute patent litigation against any entity (including a
      cross-claim or counterclaim in a lawsuit) alleging that the Work
      or a Contribution incorporated within the Work constitutes direct
      or contributory patent infringement, then any patent licenses
      granted to You under this License for that Work shall terminate
      as of the date such litigation is filed.

   4. Redistribution. You may reproduce and distribute copies of the
      Work or Derivative Works thereof in any medium, with or without
      modifications, and in Source or Object form, provided that You
      meet the following conditions:

      (a) You must give any other recipients of the Work or
          Derivative Works a copy of this License; and

      (b) You must cause any modified files to carry prominent notices
          stating that You changed the files; and

      (c) You must retain, in the Source form of any Derivative Works
          that You distribute, all copyright, patent, trademark, and
          attribution notices from the Source form of the Work,
          excluding those notices that do not pertain to any part of
          the Derivative Works; and

      (d) If the Work includes a "NOTICE" text file as part of its
          distribution, then any Derivative Works that You distribute must
          include a readable copy of the attribution notices contained
          within such NOTICE file, excluding those notices that do not
          pertain to any part of the Derivative Works, in at least one
          of the following places: within a NOTICE text file distributed
          as part of the Derivative Works; within the Source form or
          documentation, if provided along with the Derivative Works; or,
          within a display generated by the Derivative Works, if and
          wherever such third-party notices normally appear. The contents
          of the NOTICE file are for informational purposes only and
          do not modify the License. You may add Your own attribution
          notices within Derivative Works that You distribute, alongside
          or as an addendum to the NOTICE text from the Work, provided
          that such additional attribution notices cannot be construed
          as modifying the License.

      You may add Your own copyright statement to Your modifications and
      may provide additional or different license terms and conditions
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      for use, reproduction, or distribution of Your modifications, or
      for any such Derivative Works as a whole, provided Your use,
      reproduction, and distribution of the Work otherwise complies with
      the conditions stated in this License.

   5. Submission of Contributions. Unless You explicitly state otherwise,
      any Contribution intentionally submitted for inclusion in the Work
      by You to the Licensor shall be under the terms and conditions of
      this License, without any additional terms or conditions.
      Notwithstanding the above, nothing herein shall supersede or modify
      the terms of any separate license agreement you may have executed
      with Licensor regarding such Contributions.

   6. Trademarks. This License does not grant permission to use the trade
      names, trademarks, service marks, or product names of the Licensor,
      except as required for reasonable and customary use in describing the
      origin of the Work and reproducing the content of the NOTICE file.

   7. Disclaimer of Warranty. Unless required by applicable law or
      agreed to in writing, Licensor provides the Work (and each
      Contributor provides its Contributions) on an "AS IS" BASIS,
      WITHOUT WARRANTIES OR CONDITIONS OF ANY KIND, either express or
      implied, including, without limitation, any warranties or conditions
      of TITLE, NON-INFRINGEMENT, MERCHANTABILITY, or FITNESS FOR A
      PARTICULAR PURPOSE. You are solely responsible for determining the
      appropriateness of using or redistributing the Work and assume any
      risks associated with Your exercise of permissions under this License.

   8. Limitation of Liability. In no event and under no legal theory,
      whether in tort (including negligence), contract, or otherwise,
      unless required by applicable law (such as deliberate and grossly
      negligent acts) or agreed to in writing, shall any Contributor be
      liable to You for damages, including any direct, indirect, special,
      incidental, or consequential damages of any character arising as a
      result of this License or out of the use or inability to use the
      Work (including but not limited to damages for loss of goodwill,
      work stoppage, computer failure or malfunction, or any and all
      other commercial damages or losses), even if such Contributor
      has been advised of the possibility of such damages.

   9. Accepting Warranty or Additional Liability. While redistributing
      the Work or Derivative Works thereof, You may choose to offer,
      and charge a fee for, acceptance of support, warranty, indemnity,
      or other liability obligations and/or rights consistent with this
      License. However, in accepting such obligations, You may act only
      on Your own behalf and on Your sole responsibility, not on behalf
      of any other Contributor, and only if You agree to indemnify,
      defend, and hold each Contributor harmless for any liability
      incurred by, or claims asserted against, such Contributor by reason
      of your accepting any such warranty or additional liability.

   END OF TERMS AND CONDITIONS
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